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Thank you 
Thank you for continuing to stay engaged with the Beta program and for providing us with clear and 

useful feedback. We have continued to incorporate your suggestions in Dreamweaver, fix bugs, and 

fine-tune performance to release an exceptional version. The next version of Dreamweaver is shaping 

up well, and we’re delighted to partner with you in this journey.   

Keep your feedback, comments, questions, and tips coming – we’re listening. Thanks again! 

Cheers, 

The Dreamweaver Product Team 

  

https://dreamweaver.uservoice.com/
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What's new in Dreamweaver Beta 4 
This update of Dreamweaver Beta includes bug fixes and refinements to features shipped in the Beta 

releases so far. Read on for a quick introduction to these new features and enhancements. 

Onboarding  

The onboarding experience helps you set up Dreamweaver and take best advantage of the new 

features in the latest Dreamweaver.  

 

Dreamweaver onboarding screen when you start the app for the first time 

At the end of the onboarding experience, the panel displays short animated graphics that describe 

some of the most important features in this release of Dreamweaver.  

Tips: 

o Any modifications to Dreamweaver are reconfigurable using the Preferences panel. 

o Need to see the onboarding assistant again? Clear your preferences while restarting 

Dreamweaver to go through the onboarding experience again. To clear Dreamweaver 

preferences:  

 Mac: Press Cmd + Opt + Shift while launching Dreamweaver 

 Win: Press Alt + Ctrl + Shift while launching Dreamweaver 
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Find and Replace  

We’ve continued to listen to the your feedback and suggestions. The Find and Replace bar has now 

been refined further to make it easier to code. 

 

The Find and Replace bar 

• The Replace All feature is now a single-click operation. When you hit Replace All, edits to your 

content are instantaneously applied.  

o To selectively replace search results, select the Exceptions checkbox. 

• The Find and replace input fields are now bigger to accommodate multiple lines of code or 

text, and can be further expanded, when needed. 

• The Show More and Close buttons are larger and more prominent. 

• The advanced Find and Replace options are visible by default, on screens of all sizes. 

New Start Screen experience 

The new Start screen allows you to quickly access your recent files, CC files, and Starter Templates. You 

also have access to various resources tailored for your requirements.  

 

New Start Screen 

Fix for Japanese IME Input Issue  

Beta 4 contains a fix for the IME input bug that caused the input cursor to appear fixed at a position 

despite using the arrow keys to move it. Using the IME to provide inputs in Dreamweaver now works as 

expected.  
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What's new in Dreamweaver Beta 3 
This update of Dreamweaver Beta includes new features, bug fixes, and refinements to features 

shipped in Beta 1 and 2. Your feedback has been been helpful in further enhancing features and 

capabilities. Read on for a quick introduction to these new features and enhancements. 

Developer Workspace 

The all-new Developer workspace (Window > Workspace Layout > Developer) is a code-centric work 

area with an arrangement of panels and added performance boost, to deliver the best coding 

experience.This code-only environment presents a performance-optimized, fast, lightweight IDE, that 

will appeal to the coder in you.  

 

The new Developer workspace in Dreamweaver 

Compile Preprocessors without a Site    

In previous versions of Dreamweaver, preprocessor files outside a Site would automatically be compiled 

to CSS code. One could not prevent compilations of files outside Sites. From Beta 3 onwards, files 

outside a Site are not compiled automatically.  

You can now compile non-Site files yourself, on demand. Compile any SCSS/LESS/SASS file to CSS using 

the Compile (Tools > Compile) command or simply hit F9.  
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Click line numbers to select code 

This feature allows you to click the line number of code to select it. You can also drag along the 

numbers to select multiple lines of code. 

Full-screen view on Mac 

You can now view the current document in full-screen mode. For example, in Code view, you could 

increase the viewable number of lines of code by entering full-screen view. Click View > Full Screen (Ctrl 

+ Cmd + F) to maximize the current document on the screen. Press Ctrl + Cmd + F again to restore the 

document to normal view.  

ColdFusion Support 

Support for ColdFusion Markup Language includes: 

• Tag hinting 

• Attribute  hinting 

• Static function hinting  

• Pattern hints  

Source Formatting for JavaScript, JSON, and PHP files 

Beta 3 now brings you the ability to beautify your .js or .json code, and elegantly source-code format 

your .php file. Make your code more readable and easy to scan, using the Source Formatting option 

(Edit > Code > Apply Source Formatting).  

Code Hints (CSS) 

Additional code hints have been added for CSS code: 

• Pseudo classes 

• @class hints 

• Shorthand property hints 

• Properties that accept multiple values. For example, properties like background color, margin, 

padding. 

Support for PHP 5.6    

Dreamweaver now supports PHP 5.6 along with helpful features including:   

• Code and syntax hints   

• Attribute values like file path, color, and more  

• Constructs like Namespace  
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Find and Replace 

The Find and Replace feature has been enhanced with improved performance and bug fixes: 

• With larger files, Find and Replace All operations are upto 3 times faster than before. 

• The Find field is now auto-populated with selected text, when the Find feature is triggered 

after selecting text. 

• The Search Results panel now sports a Stop button. You can stop a Search operation, 

especially while searching through a file with a large number of results. 

 

• While performing a Replace All action on a large file you can click Stop to cancel the task. The 

number of times the replace action was performed until then is displayed. 

 

 

• Multi-line Search 

With Beta 3, you can now search for multiple lines within your source. Select multiple lines, 

paste them in your Find box, and click Find!  

 

Real-time Preview   

• If a Testing Server is defined, Real-time Preview will load a page directly from the testing 

server    
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What's new in Dreamweaver Beta 2 
This update of Dreamweaver Beta brings to you new features, enhancements, and re-work of Beta 1 

features, based on all the useful feedback received from you.  

Read on for a quick introduction to these new features and enhancements. 

Find and Replace 

The find/replace (Ctrl/Cmd + F) features are frequently used in Dreamweaver. However, users have 

found the floating dialog cumbersome and difficult to work with, especially while dealing with very 

large documents. The new Find and Replace functionality is a reimagined experience, to ensure that 

you find what you are looking for quickly and unobtrusively.  

The feature has also been reengineered for improved performance and enhanced functionality. 

Docked Find and Replace bar 

The find/replace functionality is now a docked bar at the top of a document window. Depending on the 

available space on your screen or your choice of view, you can see the the docked Find and Replace bar 

in three ways:  

• Default view. Available when you open the Find and Replace bar in a normal window. 

• Expanded view. Available when you click the double-chevron icon. 

• Compact view. Available when you resize the document window smaller than the default size. 

 

 

Default view 

 

Expanded view 

 

Compact view 

 

Live Highlighting of search results 

In the Find and Replace bar, while searching in the current document, Dreamweaver starts highlighting 

the content it finds as you type in the Find box. While searching in the current document, you no longer 

have to type the content you are searching for and then click the Find Next or Find All button.  Also, 

while searching in a document, the scrollbar now displays markers to denote where the search results 

are. 
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Searched strings are highlighted as you type in the Find box 

 

Search position and total results found 

In addition to being able to see your searched strings highlighted as you type in the Find box, you can 

also view the number of total results and the search position that you are at. The values are displayed 

in the Find box. 

 

Search position and total results found 

Known issues in the Find and Replace feature 

• While replacing content in all other locations other than Current Document, when you click 

Replace All, the results are displayed at the bottom of the document window in the Search 

panel. However, no content has been replaced yet. To replace content, click Replace in the 

Search panel. 

Code Hints 

New code hints now display additional additional information for the properties that have more than 

one possible sub-property. For example, an element's margin property can have specific values for the 

top, right, bottom, and left margins.  

When you type the first value of the margin property (margin-top), a code hint appears and displays 

what values will be assumed for the rest of the properties. As you continue to type, the values in the 

code hint are updated to reflect your modifications. 
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Code hints for CSS properties. 

Live Browser Preview 

In previous versions of Dreamweaver, you could see the state of a page by choosing to preview a work-

in-progress page. However, each time you updated the page, you had to save the page in 

Dreamweaver, and then reload the page in the browser to see the modifications. In this Beta release of 

Dreamweaver, you can now view changes that you are effecting in Dreamweaver, in real-time on a 

page that you are previewing in a browser.  

To use Live Browser Preview: 

1. In the toolbox, click Device Preview > Preview in Browser. A browser tab/window displays 

your webpage. 

  

Choose a browser from the Preview in browser options. 

2. Edit your webpage in Dreamweaver. Notice that the modification is instantly reflected in your 

browser. 

Note: The tab or window that presents the Live Browser Preview continues to reflect any modifications 

to the webpage as long as it is open. The tab is added to the Preview in browser list. 

Properties Inspector  

In the theme of modernization of the user interface, the Properties Inspector panel now appears in sync 
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with the rest of Dreamweaver. Any theme applied to the Dreamweaver interface is now applied to the 

Properties Inspector panel as well. 

 

The Properties Inspector panel. 
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What's new in Dreamweaver Beta 1 
This release of Dreamweaver CC (2017 Beta) brings to you a modernized, more intuitive user interface with 

a selectable dark theme, an all-new code editor, and several enhancements including support for CSS 

Pre-processors. 

Read on for a quick introduction to these new features and enhancements to existing features. 

Modern user interface 

We are excited to introduce the modernized user interface on both Mac and Windows operating 

systems. Work is still in progress and in the meanwhile, here’s a snapshot of Dreamweaver with the 

new look. 

 

New user interface - Dreamweaver (2017 Beta) release 
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User interface - Dreamweaver 2015 releases 

 

Enhanced code view 

The entire Code view in Dreamweaver is enhanced with an all-new look, and added functionality in the 

following areas: 

• Quick edit 

• Quick docs 

• Code hints 

• Code commenting 

• Code coloring 

• Code formatting 

• Code view font resizing 

• Updated status bar 

• Selection-based code collapse 

https://chl-author-preview.corp.adobe.com/content/help/en/dreamweaver/beta/whats-new-beta.html#quick-edit
https://chl-author-preview.corp.adobe.com/content/help/en/dreamweaver/beta/whats-new-beta.html#quick-docs
https://chl-author-preview.corp.adobe.com/content/help/en/dreamweaver/beta/whats-new-beta.html#code-commenting
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• Lint code 

 

Quick edit 

Quick Edit in Code View places context-specific code and tools inline to avoid switching between file tabs 

and edit the related code within the current file. 

To open the Quick Edit, place your cursor on specific code snippets and press Ctrl/Cmd-E. For example: 

• In an HTML file with the cursor inside a class or ID attribute (name or value) or on the tag name — 

Quick Edit shows you all the matching .css rules in the related files. You can edit these rules directly 

inline, without leaving the context of the HTML file. 

• When multiple rules match, use the list on the right side (or use Alt-Up/Down) to navigate among 

them. To directly create a new .css rule from the inline editor, click the New Rule button. 

• In any file with a hex color or RGB/RGBA/HSL/HSLA color, Quick Edit opens color picker to preview and 

adjust the color. 

• In a JavaScript file with the cursor on a function name, Quick Edit displays the body of the function 

(even if it is in other files referenced by a require() statement). 

• In a .css/LESS/SCSS file with the cursor on a cubic-bezier() or steps() transition timing function, Quick 

Edit displays a graphical transition curve editor. Pre-defined timing functions ease, ease-in, ease-out, 

ease-in-out, step-start, and step-end are also valid starting points. 

 

Quick edit 
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Quick docs for CSS files 

Quick Docs displays relevant documentation inline. Use Ctrl/Cmd-K to open Quick Docs. 

In a CSS/LESS/SCSS file with the cursor on a CSS property/value, Quick Docs opens documentation from 

the Web Platform Docs project. 

You can simultaneously open multiple inline editors and doc viewers. To close a single inline editor or doc 

viewer, click the "X" in the upper-left or press Escape while it has focus. To close all inline editors and 

docs, place your cursor back in the main enclosing code editor and press Escape. 

 

 

Quick docs 

 

Code hints 

In this release, code hints now provide useful information for selected JavaScript, HTML, CSS, or PHP 

code. These hints can vary depending on the code, but usually contain: 

• A description of the selected code 

• Function signature 

• A link to external documentation 

For example, for user-defined functions in JavaScript, comments preceding the function definition are 

displayed as description along with the function signature. 
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For PHP function hints, the function signature is displayed in the information section. Here are a few 

examples: 

Code hint for HTML 

 

 

 

Code hint for CSS 

 

Code hint for PHP 

 

Code hints are provided by default in the following instances: 

• CSS, LESS, SCSS — all property names, and enumerated property values (where the value is a 

discrete list of keywords). CSS Hints now has all the new hints that were missing in Dreamweaver CC 

2015. Also you now get to choose color names from hints for properties like color, background-color. 

• JS — variables and functions, using the Tern code intelligence engine. 
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• Tern makes intelligent inferences about what properties and methods a given object contains, 

based on an analysis of your code. In addition to the current file, Dreamweaver Beta looks at other 

files referenced by a require() statement. 

• In cases where Dreamweaver Beta cannot determine the hints that should be available, it will fall 

back to a list of heuristic guesses. These guesses are shown in italics. 

• JS code hints use smart matching — Type camel-case initials and other shorthand to filter the hint 

list more quickly (e.g. type "gsp" for getScrollPos). 

• You also get argument hints — while you're typing arguments to a function, an indicator above the 

cursor lists the expected types of the arguments. 

• The following code hints are retained as is from Dreamweaver CC 2015. You will continue to get static 

and dynamic hints for language constructs and site-specific (PHP) hints. 

• HTML — tag names, attribute names, attribute values, and entities. 

• XML — XML nodes and attributes 

• PHP — PHP hints are site-specific 

• Code hints for selected CC library assets are also available. 

 

Code commenting 

You can use Ctrl+/ on Windows, or Cmd+/ on Mac to toggle comments for a selection or a single line. 

Dreamweaver automatically detects the content type and inserts an appropriate comment. 

You can also continue to insert comments from the toolbar. 

 

Code coloring 

Dreamweaver now supports code coloring for HTML, JS, CSS, PHP, XML, LESS, Sass, SCSS, SVG, Bash, C, 

C#, C++, clojure, CoffeeScript, Dart, Diff, EJS, Embedded Ruby, Groovy, Handlebars, Haskell, Haxe, Java, 

JSON, Lua, Markdown, Markdown (GitHub), Perl, Properties, Python, RDF Turtle, Ruby, Scala, SQL, 

Stylus, Text, VB, VBScript, XML, and YAML. 

You can also choose between dark and light themes. 
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Code coloring 

 

Code formatting 

Auto indentation is now a much improved feature. 

This prevents manual code indentation issues where you see the start and end tags beginning on 

different columns. 

 

Code view font resizing 

Use the following keyboard shortcuts without leaving code view to resize the font: 

• Ctrl++(Win) or Cmd++(Mac) to increase font size 

• Ctrl+-(Win) or Cmd+-(Mac) to decrease font size 

• Ctrl+0(Win) or Cmd+0(Mac) to reset to default font size 

Note: The intelli-sense pop-up also zooms while you're zooming the code. 

 

Updated status bar 

Use the status bar in Code View to: 

• See the line and column number at the bottom of the screen. These numbers indicate the line and 

column where the mouse is placed. 

 

Status bar 

 

Get the code coloring and hints of various file types. 
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Toggle between INS and OVR modes by clicking INS and OVR in the status bar in the lower right corner of 

the Code View interface. 

• INS - Insert mode. Use if you want to insert text. 

• OVR - Overwrite mode. Use if you want to replace existing text with new text. 

 

Selection-based code collapse 

Selection-based code collapse is now available. Just select a block of code and click the Down arrow icon 

in the line number column. 

Tag/block or Selection-based code collapse feature will function as seen in the previous versions of 

Dreamweaver. To change the minimum code folding size, click Preferences > General. 

Click the Down arrow to collapse the selected code 

 

After code is collapsed 

 

Lint code 

Linting functionality for HTML, JS and CSS continue to function as before. However, linting is now 

triggered on file open and save only. 

To customize the errors/warnings, edit linting rule sets for HTML/CSS/JS in Preferences->Linting. 

 

CSS preprocessor 

Dreamweaver now comes with LESS and Sass preprocessors. Compile is auto triggered on file save for 

LESS and Sass files. You can also manually trigger compile from the Files panel context menu by right clicking 

over a file. If the current file is in turn imported by a parent file, then the parent file is compiled. 
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You can choose to compile a particular file or multiple files by invoking the context menu on the selected 

files from the Files Panel and clicking "Compile" option. This will trigger compilation on the selected 

file(s) and Dreamweaver will not track or figure out the imports for the selected files. However, if you 

select a folder containing CSS Preprocessor files, Dreamweaver will determine the files that ultimately 

need to be compiled. 

Alternatively, you can choose to edit a file or multiple files in Dreamweaver. Every time you save a file that 

belongs to the active site, Dreamweaver determines the imports for the file that was saved and compiles 

those dependent files for you. This is applicable only for files (that are edited and saved) that belong to 

active site. 

If you edit files that belong to an inactive site, Dreamweaver does not determine the imports. If you want 

Dreamweaver to do so, you should switch to the site containing this files so that the site is active. 

After the CSS generation is complete, the status bar in the document window turns Green. The Output 

panel (Window 

> Results) displays the generated file's path. 

Double-click the message to open the generated CSS file in a separate tab. The file is auto refreshed with 

new changes whenever a Sass/LESS file is compiled. 

If the CSS generation fails with errors, the status bar in the document window turns Red and the list of 

error messages are listed in the Output panel. Double-click the error message to go to the line where the 

error has occurred. 

Note: If the output file is linked in an HTML document in Live View, the Live view is auto refreshed with new 

CSS changes whenever the Sass/LESS file is compiled. 

Site Setup window now has a separate category for CSS Preprocessors. The changes you make are site-

specific. Here are the CSS preprocessor changes in detail: 

• Set up CSS Preprocessor site-specific preferences 

• Support for Compass 

• Support for Bourbon 

• Define location of CSS output files 

• Output panel displays CSS preprocessor compile status 
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Set up CSS Preprocessor site-specific preferences 

All CSS Preprocessor preferences are available in Site Setup > CSS Preprocessors > General. This window 

allows you to set up specific CSS preprocessor settings for each site. 

CSS Preprocessor site-specific preferences now in Site Setup dialog 

 

Site Setup - General You can enable or disable Sass/LESS files auto compilation. You can also configure the 

CSS output file parameters from this menu. By default, compilation is enabled. 

Site Setup - Source & Output You can define where the generated CSS files should be placed, and the 

path Dreamweaver should watch and trigger auto compilation when a Sass/LESS file in the path is 

modified using an external editor. 

Site Setup - Compass 

You can install Compass framework into the selected site and enable or disable Compass. By default, 

Compass is disabled. After enabling Compass, you can either point Dreamweaver to the config.rb file in 

your current site or manually specify the configurations. Click Install Files. Dreamweaver generates and 

copies the Compass files into the root folder for your site, and autoselects the config.rb file. For more 

information, see Support for Compass. 

Site Setup - Bourbon You can either install Bourbon or select the path if Bourbon is already present in 

the site. For more information, see Support for Bourbon. 

Site Setup - Bourbon Neat You can either install Bourbon Neat or select the path if Bourbon is already 

present in the site. 

Site Setup - Bourbon Bitters You can either install Bourbon Bitters or select the path if Bourbon is 

already present in the site. 
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Support for Compass 

Compass is an open-source CSS Authoring Framework that allows you to create CSS3 style sheets using 

Sass. Dreamweaver allows you to use Compass to create your style sheets. 

To use a Compass style sheet in your project, do one of the following: 

• Specify an existing Ruby-based configuration file - if you have Compass installed and a *.rb config file 

• Specify configuration options manually - if you don't have a *.rb config file 

Note: Compass can also be installed to your local site, by clicking Install Files in the Site Setup > CSS 

Preprocessors > Compass dialog box. Clicking Install Files overwrites the existing config.rb of your site (if 

any) with the default config file. 

 

Specify an existing Ruby-based configuration file 

1 In the Site Setup dialog box, select CSS Preprocessors > Compass. 

2 Select the Use Compass check box. 

 

 

 

Using the Compass CSS preprocessor 

3 If you already have a configuration file (*.rb) ready to use, click Specifying Ruby-based configuration 

file, and browse to the file location. 

Note: This file must be located in your site root folder. 

https://chl-author-preview.corp.adobe.com/content/help/en/dreamweaver/beta/whats-new-beta.html#Ruby-based
https://chl-author-preview.corp.adobe.com/content/help/en/dreamweaver/beta/whats-new-beta.html#manually
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4 Click Save. 

 

Specify configuration options manually 

If you don't have an existing configuration option, you can choose to specify them manually and build 

and install the files. 

1 In the Site Setup dialog box, select CSS Preprocessors > Compass. 

2 Select the Use Compass check box. 

3 Click Specifying Configuration Options manually. The following fields get populated automatically: 

• HTTP Path: The path to the project when running within the web server. Defaults to "/". 

• Images Directory: The directory where the images are kept. It is relative to the project_path. 

• Generated Images Directory: The directory where generated images are kept. It is relative to the 

project_path. Defaults to the value of images_dir. 

• Fonts Directory: The directory where the font files are kept. 

• Relative Assets: Indicates whether the compass helper functions should generate relative urls from 

the generated CSS to assets, or absolute urls using the http path for that asset type. 

4 Click Save. 

The config files are saved and the list of files is updated in the Files panel. 

The directories you specify will not be created as new folders under the Site. Compass uses the 

configuration settings during compilation. 

Support for Bourbon 

Dreamweaver now offers support for the Bourbon family of products: 

• Bourbon - A simple and lightweight mixing library for Sass 

• Bourbon Neat - A lightweight semantic grid framework for Sass and Bourbon 

• Bourbon Bitters - Scaffold styles, variables, and structure for Bourbon projects 

You can import the Bourbon framework by adding @import "bourbon" in your code and Dreamweaver 

uses the prepackaged version of Bourbon while compiling the preprocessor files. 

Alternatively, you can install Bourbon framework files to your site so that further updates to 

Dreamweaver will not affect your compilation workflows. The Bourbon framework files are copied to your 

site and this is the framework that is used when compilation is triggered for any of the files that import the 

framework. 
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Working with Bourbon 

 

A partial refresh is triggered on successful compilation. For example, if you have opened HTML files (in live 

view) that have linked or imported CSS files, which may or may not be present in the site. 

If these linked CSS files are generated (created or overwritten) as a result of compiling preprocessor files, 

every such HTML file is partially refreshed so that the impacted styles that come from the linked style 

sheet are applied. 

This means that you do not have to refresh the HTML pages to see if the styles from the 

generated/compiled style sheet were applied or not. These updates are instantaneous and applied via 

partial refresh so that you stay in the context of editing a fragment of the markup. 

 

Define location of CSS output files 

You can now define where to store the output CSS files. 

You can also select the sub folder inside site root that needs to be watched. This helps in auto triggering 

the CSS Preprocessor when a file is modified externally, or from within Dreamweaver. 
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Define location of CSS output files 

 

Note: This feature is a work in progress. We will continue to enhance and improve its functionality 

through future Beta releases. 

 

Output panel displays CSS preprocessor compile status 

Results of the CSS preprocessor compile are displayed in the Output panel (Window > Results > Output), and 

the status icon in the status bar is displayed in green. 

 

Output panel indicating successful CSS preprocessor compile 

 

If any errors are found, the CSS file is not compiled successfully. The status icon is shown in red and the 

Output panel lists all the errors and warnings. 

 

Output panel indicating errors in CSS preprocessor   compile 
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Double-click an error message in the panel to quickly jump to the erroneous line in the code and fix it. 

The CSS file does not compile successfully until all the errors are resolved. 

To open the compiled CSS, double-click the success message in the panel. 

 

Changes to the Files panel 

The Files panel (Window -> Files) is changed. In general, this panel is now simplified and does not include 

unnecessary buttons that are not relevant to your workflow. Instead, this panel intuitively displays buttons 

and options depending on where you are in the workflow. 

Here is a summary of the changes in the Files panel: 

• Remote and testing server buttons are changed 

• Ability to customize the columns in the Files panel 

• Other changes to the Files panel 

 

Remote and testing server buttons are changed 

In earlier versions, the icons for Remote and Testing server are displayed in the expanded files panel 

mode. Clicking these buttons changes the view on the left side of the panel. 

In this release, these are replaced with a dropdown. Selecting Remote/Testing in this dropdown changes 

the view accordingly on the left side of the panel. 

 

Files panel UI changes 

 

Ability to customize the columns in the Files panel 

You can now: 

• Add or remove columns from the Files Panel 

• Add or remove columns from Local, remote, and testing view 

 

https://chl-author-preview.corp.adobe.com/content/help/en/dreamweaver/beta/whats-new-beta.html#add
https://chl-author-preview.corp.adobe.com/content/help/en/dreamweaver/beta/whats-new-beta.html#add1
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Add or remove columns from the Files Panel 

To Add/Remove columns in the Files Panel, right-click the Column header in the Files panel to display the 

context menu. 

The context menu displays two default columns, File Names and Modified. 

If you have not selected any sites, three default columns, namely File names, Size and Modified are 

displayed. 

 

Add or remove columns from Local, remote, and testing view 

To add or remove columns, right-click on any of the Column headers in Local/Remote/Testing view. The 

column list is similar to the list in the Site set up dialog box (Advanced Category -> File View Columns). 

 

 

Other changes to the Files panel 

• Added a new button called “Define Servers” in case there are no servers defined. Clicking on this 

button brings up the Site set up dialog with server category selected to help you define the servers. 

• The Refresh button in the Files panel is moved from the toolbar to the status bar. 

 

The new Define Servers button and the moved Refresh button 

 

• None of the other server workflow-related buttons (Get/Put, Connect, and Synchronize) are visible if 

no server is defined. 
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• Removed the modified data that comes up on clicking/hovering on files/folders in status bar 

• SVN Version control is deprecated 

Changes to the Snippets panel 

There are a number of changes to the way you work with the Snippets panel. 

• Removal of code preview - Code preview when a snippet is selected is now removed from the product. 

• Simplified the experience of creating snippets - You now have a simplified dialog that allows you to 

create snippets faster. For more information, see Create snippets. 

• Replaced keyboard shortcuts with a trigger key - You can now add a trigger key to quickly insert 

snippets into your code. For more information, see Trigger key workflow to insert snippets. 

 

Create snippets 

Creating code snippets is now a breeze with the new simplified Snippet dialog that allows you to quickly 

create code snippets for later reuse without having to fill out any extraneous fields. 

 

Create snippets 

 

Trigger key workflow to insert snippets 

Assign keywords to commonly used snippets to quickly insert snippets into your code using the Trigger 

Key field. 
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Changes to the Snippets panel 

 

Add trigger keys and insert snippets using trigger keys 

1 Right-click a snippet and select Edit Trigger Key. 

 

Adding a trigger key to a snippet 

 

2 Enter the required text in the trigger key field. 
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Add the trigger text in the trigger key field 

 

Note: Trigger keys cannot contain any special characters (apart from an underscore). In addition, the same 

trigger key cannot be used for two different snippets. 

3 To add snippets into your code using trigger keys, just type in the trigger text and press Tab to insert the 

snippet into your code. 

Auto-recovery of files after a crash 

If Dreamweaver shuts down unexpectedly because of system errors, power outages, or other problems, 

then you can recover any unsaved changes made to files you were working on. 

The auto-recovery feature automatically backs up any unsaved files in Dreamweaver. If a crash occurs, 

the following dialog box is displayed during subsequent launches of Dreamweaver. 

 

Auto-recovery in Dreamweaver 

 

When you open a crashed Dreamweaver, you now recover or discard last changes to a file: 

• Recover - Select this option to open the auto-saved version of your file 
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• Discard - Select this option to open the last saved version of your file 

Note: In Dreamweaver, auto-save happens approximately every five seconds (depending on the 

operating system). 

Known issues in the crash recovery feature: 

• You must have saved your file at least once for this feature to work as documented. 

• If Dreamweaver crashes with any dialog box open, then the files cannot be recovered. 

 

Multi-cursor support 

Use multiple selections to apply the same edit to different parts of your document, for example, to add the 

same text to multiple nearby code lines, or a quick replace of all the variable instances without using the 

Find bar. 

You can also undo and redo any changes that you make with multiple cursors. There are two basic ways 

to create multiple selections: 

• Column/Rectangular selection: Hold down the Alt key, then click and drag vertically or diagonally. 

Dragging vertically adds the cursors to each line you drag across and dragging diagonally selects a 

rectangular block of text (which is really a set of selections, one on each line). As a quick shortcut to 

create multiple cursors vertically, use Shift-Alt-Up/Down to add a cursor above or below the current 

selection. 

• Non-contiguous selection: Select the source and hold down the Ctrl key (Windows) or Cmd key (Mac) 

and make another selection. The second selection is added as another selection range. 

You can also combine these techniques - hold down Ctrl-Alt or Cmd-Alt and then drag to add a 

column/rectangular selection to the existing multiple selection. 

Once you have a multiple selection, most navigation commands and edits are applicable to each cursor 

or range selection. For example, if you type, the characters you type appears at each cursor (or replace each 

selection). The arrow keys move each selection in the direction of the arrow. 

 

Multi-cursor support 

 

Using Code Hints and Quick Edit to access Color Picker 

Code hints pop up automatically when you type, but you can also manually display them with Ctrl-Space 

(Windows and Mac). With the new code view, code hints for color attribute is as follows: 
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Code hints for color 

 

When your cursor is on a specific code snippet, press Ctrl/Cmd-E to open the inline editors of the Quick 

Edit. Quick Edit opens an inline color picker to preview and adjust the color in any file with a hex color or 

RGB/RGBA/HSL/HSLA color. 

 

Use Quick edit to edit colors 

 

Workspace changes 

There are some changes to the Dreamweaver workspace. 

Removed extraneous workspaces 

The default, extract, and beginner workspaces are now removed from the toolbar. 
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New Essentials workspace 

The Essentials workspace 

The new Essentials workspace is now the default workspace. The Essentials workspace contains common 

toolbar and panels: 

• Files, 

• CC Libraries, 

• Insert, 

• CSS Designer, 

• DOM, 

• Assets, 

• Snippets 

By default, the Files Panel and DOM panel are in focus. 

 

Enhanced Dreamweaver Preferences 

The Dreamweaver preferences menu is enhanced to offer you more direct control over your project 

settings. 
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Dreamweaver preference Change description 

Code coloring You can now choose between dark and light themes. 

Code coloring customization is currently not available  
Code Format You can configure indentation, tab size, and minimum 

code folding size  Other preferences for code format 

    
Code Hints You can enable or disable code hints. And you can select 

when to auto insert closing tags  
Fonts You can select font and font size for code view. Rest of 

the preferences for Fonts are currently unavailable  
 

Toolbar changes 

Document toolbar changes 

Note: This feature is currently available only in Windows operating systems. 

The Document toolbar now has only Code, Split, and Live views listed at the center of toolbar. 

If you select a view, that view is highlighted in blue. On undocking, the document toolbar occupies very little 

horizontal space. 

In addition, the toolbar options in the menu are now moved under Windows > Toolbars. 

See the following images to compare the Document toolbar in the previous releases and the Document 

toolbar in the Dreamweaver CC (2017 Beta) release. 

 

Document toolbar - Dreamweaver CC 2015   releases 

 

Document toolbar - Dreamweaver CC (2017 Beta) release 

Note: Currently, only text is available for these views, the appearance is being worked on. 

Common toolbar changes 

The Common toolbar (previously the Coding toolbar) to the left of the Dreamweaver workspace is now 

view-specific. That is, depending on the current view, only the menu options that are applicable to that 

specific view are displayed. 

To view the Common toolbar changes, see the screenshot of the Coding toolbar from the previous releases 

and the new Common toolbar in the Dreamweaver CC (2017 Beta) release. 
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Coding toolbar - Dreamweaver 2015   releases 

 

Common toolbar – Dreamweaver CC (2017 Beta) release 

You can also choose to customize this toolbar according to your needs by adding menu options, or removing 
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unwanted menu options from the toolbar. 

To customize the toolbar, do the following: 

1 Click   in the Toolbar, to open the Customize Toolbar dialog box. 

 

Customize toolbars 

2 Select or deselect the menu options that you want available in the toolbar and click Done to save your 

toolbar. Click Restore Default to restore the default menu options. 

You can toggle the Visual Media Query Bar using the new button in the Common toolbar in Live view. 

Live view and Inspect mode buttons are also added to the Common toolbar. 
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The file management icon has changed and it now looks like this: 

 

File Management icon 

 

The following toolbar options are not implemented in this release of Dreamweaver CC (2017 Beta): 

• Collapse full tag 

• Collapse selection 

• Expand All 

• Remove comment 

• Balance Braces 

• Word Wrap 

The following toolbar options are not implemented in this release of Dreamweaver CC (2017 Beta): 

• Collapse full tag 

• Collapse selection 

• Expand All 

• Remove comment 

• Balance Braces 

• Word Wrap 

The following toolbar options are not implemented in this release of Dreamweaver CC (2017 Beta): 

• Collapse full tag 

• Collapse selection 

• Expand All 

• Remove comment 

• Balance Braces 

• Word Wrap 

 

Context menu changes 

 

 

Refresh live view from context menu 
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You can now refresh Live view, and navigate forward or backward in Live view using the context menu. 

 

 

Use the context menu to navigate forward and backward in Live    view 

 

Context menu in Code View 

If you right-click within Code view, a context menu becomes available to use. However, not all the options 

are available to use as of now. 

 

Availability of a context menu on right-click in Code view 
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The following context menu items are not available for use in this version of Dreamweaver: 

• Find Previous 

• Code Hint Tools 

• Selection -> Collapse Selection, Collapse Outside Selection, Expand Selection, Collapse full tag, and 

Collapse outside full tag 

 

Keyboard shortcut changes 

 

Shortcut Old Behavior New Behavior 

Ctrl+L Change Link or Make a link Select line 

Ctrl+[ Select Parent Outdent code 

Ctrl+] Select Child Indent code 

Ctrl+Alt+Up  Select Parent 

Ctrl+Alt+Down  Select Child 

Ctrl+D Duplicate element (Live View) Duplicate line 

Ctrl+Shift+D Get file Delete Line 

Ctrl+Alt+D  Get File 

Ctrl+/ Hide/unhide Dom Panel Toggle comment 

Ctrl+Shift+Space Insert non-breaking space Show Parameter Hints 

Ctrl+- Zoom out (Live View) Decrease Font Size (Code View) 

Zoom out (Live View) 
Ctrl+0 Zoom 100 %(Live View) Restore Font Size (Code View) Zoom 

100 

  
Ctrl+K Hide/unhide Extract panel Quick Docs 

Ctrl/Cmd+E N/A Quick Edit 

Cmd+/ or Cmd+/ Hide/unhide Dom Panel Toggle comment 

 

Non-editable content 

You cannot edit the locked regions within the template instances. 

However, currently code view does not stop you from typing within the read-only files or remote files. 

This enhancement will be addressed in future beta builds. 

 

App menu reorganization 

The Dreamweaver application menu is now reorganized based on the functionality corresponding to the 
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options. This reorganization will help new users easily discover menu options. 

 

Provide feedback 

If you have any thoughts or comments on all the exciting changes in Dreamweaver, go ahead and log a 

comment through the Feedback option embedded within Dreamweaver. 

 

The Dreamweaver feedback option 
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System requirements 

Windows 

• Intel Pentium 4 or AMD Athlon 64 processor 

• Microsoft Windows 7, Windows 8, Windows 8.1, or Windows 10 

• 2 GB of RAM 

• 1.1 GB of available hard-disk space for installation; additional free space required during installation 

(cannot install on removable flash storage devices) 

• 1280x1024 display with 16-bit video card 

• Internet connection and registration are necessary for required software activation, validation of 

subscriptions, and access to online services. 

Mac OS 

• Multicore Intel processor 

• Mac OS X versions 10.10, and 10.11 

• 2 GB of RAM 

• 1.1 GB of available hard-disk space for installation; additional free space required during installation 

(cannot install on a volume that uses a case-sensitive fi le system or on removable flash storage 

devices) 

• 1280x1024 display with 16-bit video card 

• Internet connection and registration are necessary for required software activation, validation of 

subscriptions, and access to online services. 

Language versions 

Dreamweaver CC is available in the following languages: Deutsch 

English Español Français Français* Hebrew* Italiano Nederlands Polish 

Português (Brasil) Svenska 

Turkish čeština Русский 

بيرع  

日本語 

简体中文* 

繁體中文* 

한국어* 
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* Chinese Simplified, Chinese Traditional, and Korean are available for Windows only. Arabic and Hebrew 

versions have localized support and features with an English interface. North African French (Français*) 

version has localized support and features with a French interface. 

Feature requests, feedback, and bug reporting 
If you encounter a problem with Dreamweaver CC (2017 Beta), or would like to submit a feature request 

or provide feedback, do one of the following: 

• Click the Feedback button at the top right corner of the Dreamweaver user interface. For more 

information, see Provide feedback; or 

• Go to UserVoice and log in using the same email ID you used to create your Adobe ID. 

 

The Dreamweaver feedback option 

 

 

To contact us directly about Dreamweaver bugs, email us at dw_bugs@adobe.com . 

Do not post screen shots of bug examples on public websites, as this is a violation of the confidentiality 

agreement you agreed to when entering this program. 

Note: Windows crash logs are no longer posted to the desktop (with an Info dialog). Instead, they are 

silently written to your config folder. If you suspect Dreamweaver on Windows crashed, you can now look 

in the config folder. 

On Mac, there is a feature called Adobe Crash Reporter. This component launches when you experience a 

crash and gathers data specifically about the crash to send to Adobe. If you encounter a crash on a Mac, 

use the following steps to submit the crash report and report a bug about the issue. 

1 If Dreamweaver crashes, Adobe Crash Reporter is launched. 

2 Log a bug using the normal steps. Please copy and paste all text from the Crash Report section into the 

Bug Description beneath the steps to reproduce. Fill out all required fields and save the bug. 

3 Enter the bug number in the Optional Problem Description in Crash Reporter along with steps and click 

Send To Adobe. 

https://dreamweaver.uservoice.com/
mailto:dw_bugs@adobe.com
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Known issues 
Adobe identified the following issues at the time this Dreamweaver Beta was released. 

• The ‘Wait’ cursor is visible on menus that have sub-menus and dialogs (for example, Preferences panel, New 
Document dialog, and the Find and Replace bar. 

• Dreamweaver may display a blank white screen for a new user, after the onboarding panel is dismissed. 
• Code view appears blank upon pressing Ctrl+N/Cmd+N after changing New Document dialog keyboard shortcut. 
• While changing and assigning keyboard shortcuts, Dreamweaver continues to detect shortcuts keys pressed and 

may perform actions in the background. 
• For JS files, Linter error messages in Output panel disappear on pressing any key Code view. 
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Installing Dreamweaver Beta Builds 
Dreamweaver CC (2017 Beta) build on Win (9224) and Mac (9224) is available for you to test and provide 

feedback. 

Please note that the development of features and the user interface are not complete and will evolve over 

the course of the prerelease program. Your feedback will help us improve Dreamweaver. Please share your 

feature requests and bug reports on the prerelease web site. 

Coexistence of Dreamweaver Beta and previous Dreamweaver CC releases 

• The Dreamweaver Beta build can be launched along with any installed version of Dreamweaver on 

both Win and Mac 

• Preferences and keyboard shortcuts will not be migrated into the Beta Builds 

• You cannot import sync settings from previous installed versions of Dreamweaver 

• Beta builds have a separate version number called 16.6 

• Beta builds have separate preferences created in the below locations on Mac and Win: 

• MAC: 

• ~/Library/Preferences/ Adobe Dreamweaver Beta Prefs 

• ~/Library/Application Support/Adobe/ Dreamweaver Beta 

• WIN: 

• HKEY_CURRENT_USER/Software/Adobe/Dreamweaver Beta 

• C:\Users\<username>\AppData\Roaming\Adobe\Dreamweaver Beta 

• The sites created in the Beta builds will be created under a separate folder in the Common folder 

called 16.6 

Before you install 

• Considering this is a very early preview, this build should be used for testing purposes only. Do not 

deploy it in a production environment. 

• Back up your site before working with this build. Also, back up your site definitions from the shipped 

version of the product using Site > Manage Sites > Export. 

Uninstalling previous builds of Dreamweaver 
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If you have an already installed Beta build, uninstall it, and then run a script we have shared to manually 

clean up any leftover files. These files are left behind after uninstallation due to an existing bug in the 

Beta build installer. 

This script removes all Dreamweaver Beta build preferences, installed folder and user configuration in 

App Data. 

Note: This script does not take any back-up. All the files and folders listed above are permanently deleted 

when you run this script. 

Note: If you have created any new Snippets in the Alpha 1 build then you need to take a backup of the 

snippets before uninstalling the Alpha 1 build. 

On Mac: 

1 Download CleanupDWBetaFiles.sh from the prerelease download page. 

2 Quit Dreamweaver Beta if it is launched and make sure Dreamweaver Beta or Dreamweaver Beta 

Helper processes 

are not visible in the Activity Monitor. If processes are running, kill the process by selecting the process 

row and by clicking  in Activity Monitor. 

3 Run the following command in the terminal:sudo sh <Path to DeleteDWBetaFolders.sh> 

This removes all Dreamweaver Beta files left behind by the Dreamweaver Beta uninstaller. 

On Windows: 

1 Download CleanupDWBetaFiles.bat from prerelease download page. 

2 Quit Dreamweaver Beta if it is launched and make sure Dreamweaver Beta or Dreamweaver Beta 

Helper processes are not visible in the Task Manager. If processes are running, kill them by right-clicking 

on the process and clicking End Task in Task Manager. 

3 Launch Cmd as Administrator by right-clicking the Command Prompt shortcut in Windows Start menu. 

4 Run the following command:<DesktopPath>\DeleteDWBetaFolders.bat 

This removes all Dreamweaver Beta files left behind by Dreamweaver Beta uninstaller. 

Prerequisites to run 64-bit Dreamweaver 64-bit OS: 

To check if your operating system is 64-bit, follow the steps in the articles below: 

• Windows:     http://support.microsoft.com/kb/827218 

• Mac: http://support.apple.com/kb/ht3696 

Installation instructions 

1 Download the Dreamweaver Beta build from the Builds section of the prerelease site. 

http://support.microsoft.com/kb/827218
http://support.apple.com/kb/ht3696
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2 Extract the build to a folder and then, run the installer. 

By default, the folder extracts to /desktop/Dreamweaver Beta. 

Dreamweaver Beta will automatically launch after the installation is complete. 

To verify if the build is successfully installed, check for the right build number:  

• Windows: 9224 

• Mac: 9224 
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